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1. Introduction and system and hardware requirements 
 

Wardrobe Module is an additional module for CAD Decor, CAD Kitchens and CAD 
Decor PRO. Wardrobe Module lets you quickly design any recessed or corner 
wardrobe, closet arrangement or bookshelf, matched to the size of the wall recess in a 
room generated in CAD Decor, CAD Kitchens or CAD Decor PRO, and insert it into the 
design.  
 

The module should be launched by clicking the  ‘Wardrobes’ icon  on the CAD-Decor 
icon bar (in CAD Decor) or CAD-Interiors (in CAD Kitchens and CAD Decor PRO) and by 
clicking on the wall (or a recess in the wall) where you want to place the wardrobe. The 
module will also open when you edit the wardrobe already inserted in CAD Decor, CAD 
Kitchens or CAD Decor PRO. For more information on starting the program, see 
Chapter 3 on page 7.  
 
Until the activation code for the module is entered, only a demo version will be 
available. When you enter the code, you will gain access to the full version. Demo 
version limitations are as follows: 
 

 no possibility of inserting wardrobe into the CAD environment, 
 visible sign ‘Demo – test product…’ in the main module window, 
 limited number of elements that can be inserted into the wardrobe, 
 no possibility of generating the reports, 
 no possibility of creating illustrations, 
 no possibility of saving the wardrobe design,  
 no possibility of saving your own modules, 
 no possibility of changing the recess parameters: adding bevels and modifying the 

width, length and depth.  
 

System requirements 
 operating system: Windows XP (SP2) - 32-bit Vista - 32/64 bit, Windows 7 or 8 - 32/64 

bit (our software is not compatible with Linux and Mac OS);
 .4CAD software (included with our software at no additional charge); 



Minimum hardware requirements  - does not guarantee smooth operation 
 processor: 2.0 GHz single-core; 
 RAM: Windows XP - 2 GB, Windows Vista/7/8 - 4 GB; 
 graphics card Nvidia GeForce 8600 GT series (512 RAM) or higher (cards supporting 

OpenGL 3.0 and GLSL 1.3 or higher); 
 

Recommended hardware requirements  - for smooth and comfortable operation 
 processor: mutli-core 2.6 GHz;  
 RAM : 4 GB;  
 graphics card Nvidia GeForce (memory size 768 MB or more); 
 
More information on system and hardware requirements can be found on our website 
www.cadprojekt.com.pl in the Designers Zone, in the Technical Support tab. 
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2. Installation of the Wardrobe Module 
 

Installation of the Wardrobe Module can be conducted in two ways. For the new 
clients it will take place during the installation of CAD Decor, CAD Kitchens and CAD 
Decor PRO programs. And the existing users of these programs will install it using a 
separate installer. Its operation has been described below.  
 
The correct installation location is the main directory of one of CAD programs. After 
the installation, a new subdirectory SzafyWnekowe will appear in that location. 
 
When you run the Wardrobe Module installer (WardrobeModule.exe), you will be 
guided through the subsequent steps of the installation. All other programs should be 
closed during the installation. To go to the next step, click ‘Next >‘.  
 

 
Fig. 1 - Welcome screen of the Wardrobe Module Installation Wizard 

 
The installation process can be 
aborted at any time by clicking 
the ‘Cancel >‘ button but in this 
case the module will not be 
installed and will not work. The 
installation can be restarted at a 
later time.  

Fig. 2 - Information about the consequences of aborting the 
installation 

 
The first step is to choose the destination location for the installation of the module. 
The default installation location is the ‘Directory of the detected program’ for CAD 
Kitchens 6.X, CAD Decor or CAD Decor PRO 2.x. The installer will search your computer 
for directories of the installed programs and display their list to choose from (Fig. 3 on 
the next page).  
Module installation directory can also be specified by the user - selecting the second 
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option: ‘Directory selected manually’. This option was added in case for some reason 
the directory for any of the above programs has not been detected (despite the fact 
that the programs are installed on the computer). Select this option to open the 
‘Browse for a directory’ window to manually select the directory for CAD Kitchens 6.X, 
CAD Decor PRO, or CAD Decor 2.X, and confirm by pressing ‘Ok’ (Fig. 4). 
 
If the specified directory is not the location where the above programs are installed, 
you will be informed (Fig. 5). In this case search for the installation directory again. 
 

 
Fig. 3 - Selection of the installation location - installation in the main  

directory of CAD Decor PRO 

 
 
 
 
 

 
Fig. 4 - Request to confirm installation  

at this location  

 

 
Fig. 5 - Request to confirm installation at this location 

 
After selecting the destination location, click ‘Install’ to proceed to the actual 
installation.  
The installation consists of a series of steps, the progress of which is shown on the 
progress bars (Figures 6 and 7). These steps are the successive stages of copying and 
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installing the module components: 
 

 main module structure archive - the structure of directories being installed in 
subdirectory SzafyWnekowe; 

 intermediary library archive - this applies to library SzafyWnekoweDll, which is 
installed in the main directory of CAD Kitchens, CAD Decor PRO or CAD Decor. 

 other libraries archive - i.e. the external libraries needed to run the module, which 
are installed in subdirectory SzafyWnekowe; 

 installation of fonts - the module uses the Calibri font, so its installation is provided 
in case it is missing from the system. 
 

 
Fig. 6 - Installation process - copying the main module structure archive 

 

 
Fig. 7 - Installation process - installing the main module structure 

 
The installation process takes a few seconds. After its successful completion, you will 
be informed that the installation has been completed (Fig. 8 on the next page).  
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Fig. 8 - Information about successful installation 

 
After clicking ‘Finish’ the installer will close and you can start using our software (note 
that in order to run the Wardrobe Module you must first start CAD Kitchens, CAD 
Decor PRO or CAD Decor, and the module can only be open from within them, using 
the ‘Wardrobes‘ icon  - for more information, see section 3 below. 

 
3. Starting work with the module 
 

3.1. Introduction 
 

To start the Wardrobe Module, at any stage of work in our CAD 
software, after inserting the walls, select the ‘Wardrobes’ icon 

 on the CAD-Interiors bar (in CAD Decor PRO and CAD 
Kitchens) or the CAD-Decor bar (in CAD Decor) (Fig. 9).  

 
 

 
 

 
Fig. 9 - CAD-Interiors 

icon bar in CAD Decor 
PRO and CAD Kitchens  

 
After clicking the icon, click on the edge of the wall. You can also select the wall first, 
and then click on the icon starting the module. In both cases, the module's main 
window will open (start may take a few seconds) (Fig. 12 on the next page).  
 
If this is the first start of the module after installation, you are 
prompted to select the language (Fig. 10), and then enter the 
activation code you received when purchasing the module            
(Fig. 11 on the next page). Language selection is necessary after 
each re-installation of the module. 

 
Fig. 10 - Language 

selection  

 
The module will also open when you edit the existing wardrobe, previously inserted in 
one of our CAD programs. 
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Figure 11 - Entering the code for the Wardrobe Module after starting it from within  

CAD Kitchens, CAD Decor PRO or CAD Decor 

 
Immediately after starting the module the ‘Basic Options Wizard’ opens, in which you 
select the database, based on which the wardrobe design will be created (Fig. 12). At 
the moment, the only choice is the Universal Database; in the future manufacturer 
databases will be also available. 
 
The database will be loaded after selecting it by clicking on the manufacturer logo, and 
you will be taken to the next step, i.e. selection of the system in the database. Then 
you can go to the next steps in the design creation wizard, or close it and start working 
in the main window (respectively ‘Next >‘ and ‘Close’). You can also obtain information 
about the manufacturer, such as addresses of its representatives throughout Poland 
(more information on this topic can be found in section 3.2. on page 9). The next steps 
of the ‘Basic Options Wizard’ are described in the next section of this manual. 
 

 
Fig. 12 - View of the main window after starting the module 

 
Navigating the module can done using the mouse:  
 move - hold the right mouse button down and move the mouse to the right or left 

and up or down; 
 turn - hold the left mouse button down and move the mouse to the right or left 

and up or down; 
 zoom in and out - hold the mouse wheel down and move the mouse back and 

forth. 
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In addition, view control panel buttons are available under 

the ‘View Panel’ icon  in the middle tab in the top 
menu - ‘View’. This icon displays the arrow keys to move 
and symbols  and  to zoom in or zoom out in the 
upper right corner of the screen. To move the image, click 
the left mouse button on the appropriate symbol (Fig. 13). 
 

 
 

 
Fig. 13 - View Panel 

You can customise the appearance of the background using the ‘Options’ icon  
available in the top menu tab ‘View’. More information can be found in section 4.4. on 
page 20. With this icon you can set the following display options: 
 transparency of option windows; 
 background colour of the screen; 
 floor line colour.  
 
Operation of the module is based on the functions available on several levels: 
 The basic wardrobe design can be created in the ‘Basic Options Wizard’, which 

starts automatically when you launch the Wardrobe Module; 
 There are also a number of options in the top menu - tabs: ‘Design’, ‘Edit’, ‘View’, 

‘Options’ and ‘Help’; 
 In addition, you can use the functions available in the panel on the left side of the 

screen: ‘Recess’, ‘Construction’, ‘Elements’, ‘Modules’, ‘Materials’, ‘Summary’; 
 Also available to the user is the context menu, which activates after selecting a 

specific element of the wardrobe and pressing the right mouse button (different 
options depending on the type of the selected element); 

 Furthermore,  a list of useful keyboard shortcuts can be found under the ‘Keyboard 

shortcuts’ icon  in the ‘Help’ tab. Shortcuts to these operations can also be 
customised. More information can be found in section 4.6 on page 36. 

3.2. Basic Options Wizard - Step 1: Select the manufacturer and system 
 

Wizard window is collapsed by default at the first start (Fig. 14). After selecting the 
database (by left-clicking at the manufacturer’s logo), the user is automatically 
transferred to the second step, the selection of a system (sliding or opening doors) and 
now has the opportunity to expend the right part of the window using the ‘Expand >‘ 
button (Fig. 15).  
 

Note! All the values in the Wardrobe Module are given in millimetres. 

Note! Wardrobe Module is updated by the iUpdate application simultaneously with updating CAD 
Decor, CAD Kitchens and CAD Decor PRO programs. 
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       Fig. 14 - View of the wizard                                           Fig. 15 - Selected database and door system  
after starting a new design in the module               - expanded preview panel presenting selected products 
 

 

After selecting the database, the user can obtain data on the manufacturer. The 
‘Information’ screen opens with contact details concerning offices, representatives 
and service points of the manufacturer, in particular provinces (Fig. 16).  
 

 
Fig. 16 - Information about manufacturer - contact details and location of branches 

3.3. Basic Options Wizard - Step 2: Fill in order data 
 

Figures 17 and 18 below illustrate the collapsed and expanded wizard window at the 
stage of filling in the order data. After entering the order number and information 
about the customer (‘Customer details’, ‘Address’) and optionally also your data 
(‘Studio details, ‘Address’), click the ‘Next >‘ button at the top of the window to 
proceed to the next step.  
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           Fig. 17 - Collapsed Basic                                               Fig. 18 - Expanded wizard - filling in order data    
             Options Wizard window               

 
If customer or studio data are already given in the CAD Kitchens, CAD Decor PRO or 
CAD Decor they will be automatically loaded by the wizard.  
 
These data can be added in the main program in two places: 
 

 customer data: when you start a design in the ‘New design details’ window (Figure 
19 on the next page); 

 customer and studio data: selecting ‘Document options’ in the ‘File’ menu, which 
opens the ‘Design details:’ window (Figure 20 on the next page). 

 
However, not all data will be filled in by default in the wizard. You can fill in the missing 
data yourself. These data include: customer name, customer tax no. and website 
address (in the customer data), as well as the name of the designer executing the 
order (in the studio data). This situation is shown in Figure 18 above. 
 

To quickly clear all customer or studio data, please use the button  ‘Clear data ...’. 
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Fig. 19 - Filling in design data in CAD Decor PRO 

 

 
Fig. 20 - Filling in design and studio data in CAD Decor PRO 

- ‘Document options’ in the main menu ‘File’ 

 
3.4. Loading the last and default settings 
 

In the first step of the ‘Basic Options Wizard’ you can use the ‘Load settings’ button in 
the lower left corner that allows you to load the default settings or recently made 
settings for the entire wardrobe design.  
 
When you select ‘Default’ or ‘Last’, not only the data for the last order are loaded but 
also the dimensions of the recess, wardrobe options, colours schemes, materials and 
external door settings (available for editing in the next steps of the wizard and 
described in the following sections of this manual).  
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After proceeding to the next step, the ‘Load ...’ button becomes inactive. However, 
you can always return to the first window in the wizard, selecting the ‘<Back’ button 
and use this function. 
 
The program loads the default settings from the main program (e.g. dimensions and 
shape of the recess indicated for the wardrobe, customer and studio data entered) or 
from the currently selected wardrobe database (e.g. colour templates). Last settings 
are those that were defined during the previous Wardrobe Module session. 

 
3.5. Basic Options Wizard - Step 3: recess dimensions 
 

The second step of wardrobe design is to determine the parameters of the recess, 
where it will be installed. The module automatically adjusts the shape of the wardrobe 
to the wall parameters detected in the CAD environment in CAD Kitchens, CAD Decor 
PRO and CAD Decor (i.e. the dimensions of the recess, bevels). These dimensions can 
be freely adjusted to your needs.  
 
When determining the dimensions of the recess, four panels must be filled out:  
 
 

 ‘Basic dimensions’ - the width and height of the recess and the left and right depth 
- separated in case the recess was shallower on one side (default depth is 670 mm). 
 

 ‘Left ceiling bevel’ - if the wall bevel has not been specified into the CAD 
environment, remember that the bevel is present by clicking the ‘bevel present’ 
check-box, and then specify the knee wall dimensions (dimension A in the diagram) 
and the width of the bevel on the ceiling (dimension B). 

 

 ‘Right ceiling bevel’ - as above; the total value of the width of the two bevels on 
the ceiling may not exceed the width of the entire recess. 

 

 ‘Spacing between the recess and the wardrobe’ - the default spacing, i.e. the 
distance by which the wardrobe is moved away from the edge of the recess (left, 
right, top and back) is equal to 0 mm, this value can be changed. 
 

The illustration on the next page (Figure 21) shows the input of data for the bevel and 
the effect of the settings in the preview.  
 
The changes are constantly updated in the preview in the visualisation panel - just click 
on the next edit box so the last these values can be displayed in the visualisation.  
 
The wizard window can be collapsed in order to gain a better view of the changes in 
the preview of the model (‘Collapse’ button) -  the schematic drawing on the right side 
of the wizard will then be hidden. 
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Fig. 21 - Setting the dimensions of the recess with an uneven depth and left ceiling bevel 

 
3.6. Basic Options Wizard - Step 4: wardrobe options 
 

At this stage, there are another four panels with parameters: ‘Wardrobe base, 
‘Wardrobe top, ‘Walls’ and ‘Internal division’. Some of these options are selected by 
default (floor board and full floor, roof, walls: left, right and back, storage) (Fig. 22). At 
this point you can decide whether the wardrobe will have a floor and should it be a full 
floor, add a ceiling with editable height, remove walls and set the height and number 
of cells for the storage space and the main module and decide whether the storage 
should have separate doors. 
 

 
Fig. 22 - Third step of wardrobe design 

 
Fig. 23 - selection of filler strips  

 

 
Fig. 24 - selected external filler 

strips - you can set  their 
depth and width 
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In addition, under the ‘Advanced’ button, straight, angular and external filler strips 
are available, as well as the ‘no filler strip’ option. After selecting the type of the filler 
strips, you can define their parameters (Figures 23 and 24 on the previous page). Note: 
when you select the exterior filler strip, you will not be able to use separate doors for 
the storage space, because such filler strip cannot be divided (if the storage space door 
has been already separated, after selecting external filler strip it will disappear).  
 
3.7. Basic Options Wizard - Step 5: Schemes and materials 
 

The next step in the wizard is to define the materials to be used on the outside and 
inside of the wardrobe and the drawers model. First, select the type of your global 
template (responsible for the colours of the interior and exterior of the wardrobe) in 
the ‘Settings template’. There are two categories of templates (Figure 25 and 26): 
 

 ‘Predefined’ - colour schemes stored by default in the database; during the first 
use of the module it is the only category available; 

 ‘User’ - templates saved by the user (not available during the first time), with any 
names. For them to be accessible, you have to close the wizard, open the 
‘Materials’ tab on the left side of the screen and, after selecting the settings, save 
your own templates. More information on saving your own colour schemes can be 
found in section 5.6.2. on page 48.  
 

 

 
Fig. 25 - Defining settings template  

 
Fig. 26 - Defining exterior materials template  

 
After selecting the global template, you can also change the materials templates 
separately for exterior and interior of the wardrobe: 
 

 ‘Exterior materials template’ - is responsible for the colours of the panels: the side 
and rear panels, doorstops, floor, base, supports, ceiling, roof and lowering. 

 ‘Interior materials template’ - determines the colours of the internal components: 
main and secondary partitions, shelves: main, additional and storage. 

 
Also, these schemes are divided into pre-defined, i. e. stored in the database, or user-
defined. Their creation is described in section 5.6.2. on page 48.  
 
A third possibility is a colour ‘determined by the global settings template’, i. e. based 
on the  ‘Settings template’ selected above (Figure 27 on the next page).  

Note! When you select ‘Storage main shelf divides the door’ option and if the wardrobe doors are 
included in the design, the separated storage space will have its own separate door.  
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The currently selected materials for each component of the wardrobe are presented in 
the wardrobe previews on the right side of the window (Figure 27). 
 

 
Fig. 27 - Selecting the interior materials template 

 
After setting the colour schemes you can also choose the drawer model to be used in 
the wardrobe design. Before the introduction of your own models, only the items 
stored in the database by default are available. To add your own models, close the 
‘Basic Options Wizard’, enter the ‘Options’ tab in the top menu and select the fourth 
icon - ‘Drawer editor’. More information can be found in section 4.5.1. on page 26.  
 
3.8. Basic Options Wizard - Step 6: Exterior doors 
 

The last step of the wizard is to adjust the basic exterior door options to suit your 
needs (Figure 28 on the next page). Here you can define the following parameters: 
 

 ‘Group of door systems’ - selection of the group to which the door system belongs; 
 ‘Door system’ - selection of the system from those available in the selected group; 
 ‘Type of side profiles’, ‘Type of upper profiles’, ‘Type of bottom profiles’, ‘Upper 

track’, ‘Bottom track’ - selection of the type and colour of individual elements; 
 ‘Filling colour’ - selection of material for the door leaves;  
 ‘Number of leaves’ - defines the number of vertical divisions of the door;  
 ‘Door present in the design’ - allows to decide whether the design is to feature a 

door at all - if not, you should deselect this option (it is selected by default); 
 ‘Door visible in the design’ - allows to determine the visibility of the door while 

designing the wardrobe; this option is selected by default, so the door will be 
visible; the door can be moved in the design to reveal the given part of the 
wardrobe, or it can be also made transparent (upper menu: ‘View’ tab, third icon 
‘Door transparency’). 
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Fig. 28 - Setting the parameters of exterior doors 

 
Advanced door options are available in the ‘Options’ tab in the top menu (fifth icon 
‘Sliding door editor’) and in the sidebar under the ‘Construction’ tab (under the ‘Door’ 
button). They are described in subsequent sections of this manual (see section 4.5 on 
page 26 and 5.3. on page 40).  
 
4. Functions of the tabs in the top menu 
 

4.1. Introduction 
 

The top menu of the module is divided into five tabs containing groups of features: 
‘Design’, ‘Edit’, ‘View’, ‘Options’ and ‘Help’. These tabs are described in detail in the 
following subsections.  

In addition, in the upper right corner of the screen there is the ‘Calculator’ icon  
opening the calculator. It is always available, regardless of the selected tab.  
 
4.2. ‘Design’ tab 
 

Here you will find the basic design functions, i.e. selecting the database, saving or 
opening a design and exiting the Wardrobe Module. Available options:  
 

 - ‘Change database’ - to select the database to be used in the current design. 
When you click this icon, the ‘database selection window’ opens, which you already 
know from section 3.2. on page 9. In this window you can select the manufacturer and 
one of the systems offered by them. Under the ‘Information’ button you can access 
the manufacturer data (including representatives and service outlets in various 
provinces around Poland). To confirm the database, click ‘Ok’ and to cancel the 
changes, select ‘Cancel’. 



                

                                  

18 

 

 - ‘Customer and 
studio data editor’ - opens 
the ‘Edit data’ window, in 
which you can add or 
change the order data (Fig. 
29) (it can also be filled out 
in the second step of the 
‘Basic Options Wizard’ – 
see pages 10, 11 and 12).  
 
To save your changes, click 
‘Ok’ and to reject them, 
click ‘Cancel’.  

Fig. 29 - Customer and studio data editor  
 

 - ‘New design’ – begins a design of a new wardrobe and opens the ‘Basic Options 
Wizard’, which again will guide you through the basic design steps. However, you can 
close the wizard and conduct the design work in your own way. Clicking this icon will 
cause that your previous settings will be lost, if they were not previously saved (the 
icon ‘Save As’). 
  

 - ‘Save as’ - save the current design 
on your computer (the default save 
location is the warMagazine folder in the  
SzafyWnekowe directory in program 
location, i. e. c:\CadProjekt\CAD Decor 
Pro\SzafyWnekowe\db\warMagazine\). 
When you click on the name of a saved 
wardrobe design, a schematic view of the 
model is shown on the right side of the 
‘Save wardrobe’ window (Fig. 30).  
 
There are additional two icons available: 
 

  ‘Delete selected wardrobe’ - deletes 
previously saved, selected model. 
 

  ‘Change default folder’ - allows to 
change the default location for saving 
wardrobe designs. When selected, in a 
new window ‘Browse for folder’ (Fig. 31), 
you can select a new save location. 

 
 

 
Fig. 30 - Dialog box for saving a new wardrobe model 

 

 
Fig. 31 - Selection of a new directory for saving 

wardrobe designs 
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 - ‘Load wardrobe’ - opens the ‘Select wardrobe’ window, similar in appearance 
to the ‘Save wardrobe’ dialog box (Figure 29 on previous page), where you can select 
and open a previously saved wardrobe design. Model previews appearing on the right 
side of the window after clicking the name of the saved model can be helpful in making 
the selection. 
 
 

 - ‘Close and insert the wardrobe without doors’ - exits the module and inserts 
the currently designed wardrobe without doors into the previously specified location 
in a design prepared in the CAD software. This option allows to quickly and easily view 
and show the inside of the wardrobe in the visualisation without removing the door. 
 

 - ‘Close and insert the wardrobe’ - exits the module and inserts the currently 
designed wardrobe (with doors) in the design on the interior in the CAD software. 
 
4.3. ‘Edit’ tab  
 

The icons found here are used to perform basic operations on the elements - select, 
delete, copy, undo. Here you can also set the reposition offset (distance by which a 
single move will shift element). Available options: 
 
 

 - ‘Select’ - this button is used as the exit from other tools and by default activates 
the selection tool (the same effect as right-clicking outside the model), for example, to 
complete the insertion of shelves, you can click this button, which will turn selecting 
on. Then when you click the left mouse button on the selected wardrobe element, 
another shelf will not be inserted, but the element will be selected (and can be edited). 
To select more than one item at a time, hold down the [Ctrl] key and click the left 
mouse button on the items. To deselect one of the selected elements, hold [Shift] and 
click on the item. 
 

 - ‘Deselect’ - this deselect a previously selected element. 
 

 - ‘Delete selected elements’- deletes the currently selected part of the wardrobe. 
 

 - ‘Copy’ - copies the selected element (only one element at a time). 
 

 - ‘Paste’ - pastes the previously copied element in the indicated location. 
 

 - ‘Undo’ and ‘Redo’ - buttons to cancel the last operation, and to redo the 
cancelled operation. Options to undo and redo the last operation are also available 
under the shortcuts that can be set in the ‘Keyboard shortcuts’ window available in 
the last tab of upper menu - ‘Help’. Traditionally the undo operation is available by the 
simultaneously pressing [Ctrl + Z], and redo: [Ctrl + Y], but you can set your own 
shortcut commands. You can undo or redo up to 100 steps. 
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 - here you can set the desired reposition offset (this function is also 
available from the context menu – please go to page 64). 
 
4.4. ‘View’ tab 
 

The icons in this tab allow you to modify the view (e.g. hide the doors and walls, 
display a linear diagram) and saved images (type and appearance of dimension lines, 
the selection of layouts to be saved). It is also possible to activate the view control 
panel that you can use to navigate through the visualisation. 
 

  - ‘Door’ - shows or hides the wardrobe door (when the icon is highlighted in 
orange, the doors are visible). 
 

  - ‘Walls’ - hides or shows the walls of the recess. 
 

  - ‘Door transparency‘ - when the ‘Door’ icon is 
activated, its look changes: the padlock symbol disappears 
and the black colour turns white. When you click the 
button that looks like this, a window appears in which you 
can change the visibility of the door. At the minimum value 
(0) the doors are completely opaque, and at the maximum 
value (100) - completely transparent. The current value is 
displayed when you move the slider (Fig. 32). The setting is 
remembered after restart. 
 

  - ‘View panel’ - opens the view control panel: 
arrows, with which you can move the camera, and a 

buttons to zoom in  and out  (Fig. 33). Disabled 
icon is grey, enabled is orange (disabled is default). 
 

 
 

Fig. 32 - Changing the visibility 
of the wardrobe door 

 

 
Fig. 33 - View panel 

  - ‘Linear view’ - enables and disables the linear view of the wardrobe design 
preview (Figure 34 on the next page). Doors are invisible in the linear view. 
 

  - ‘Show notes’ - displays previously entered notes. To add a note: 
 select the ‘Notes’ option in the ‘Elements’ tab in the side menu or use the shortcut 

set in the ‘Keyboard shortcuts’ window (for more information go to page 38),  
 left-click on the element of the wardrobe for which the note is to be added, 
 determine the location of the note with a second left-click, 
 enter the text in the ‘Adding notes’ window, 
 confirm it with the ‘OK’ button (Fig. 35).  
 
A note can be inserted with a frame (default) or without it (when the ‘frame’ option is 
deselected). 
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The size of the note may be adjusted by clicking  (e.g. where the text goes to the 
next line). Size of the text is not editable, but the colour can be changed in the same 
place where the colour of dimension lines is determined in the ‘Dimensions menu’, 
under the icon of the same name, in ‘Text options’ pane (as described on page 23).  
 

 
Fig. 34 - Linear view of the wardrobe in the visualisation 

 

 
Fig. 35 - Adding notes to the model 

  - ‘Display dimensions’ - after clicking the icon turns orange, and dimension 
lines appear in the model preview (Fig. 36).  
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Fig. 36 - Examples of dimensioning the wardrobe model – Dimension menu 

 
At this point the next icon in the ‘View’ tab: ‘Dimensions menu’ becomes active 
(padlock symbol disappears and the arrow changes from black to white), which lets 
you open the window where you can, for example, set the dimension lines colour (see 
description below) (Fig. 36 above). When displaying the dimensions, the schematic 
floor lines disappear from the preview. 
 

  - ‘Dimensions menu’ - this icon becomes active when the dimensions are 
enabled in the model (under the icon ‘Dimensions’ - it then changes the colour to 
white and the lock disappears); clicking on it opens the ‘Dimensions menu’ window 
(Fig. 37 on the next page), which includes the following panels: 
 

 ‘View’ - front or rear view, from the top or the bottom, or from the right or left - 
depending on the selected option, the model turns and displays the desired view; 

 ‘View options’ - the selections include presentation of dimensions in the form of 
lines, lines with values or numbers; 

 ‘Dimensions for’ - allows for selecting the components of the wardrobe, which will 
be dimensioned (the ‘inner measurement’ displays the dimensions for divided 
cells, for example, a value of 3 means that the sizes of the cell divided twice, e.g. 
horizontally and vertically, are displayed; and the value of 1 - for an undivided cell); 

 ‘Text options’ - allows you to set the size and offset of dimension text, line spacing 
and colour change (‘Change’ button opens the ‘Colour’ window, where you can 
choose a basic or custom colour). Changing the colour of text and dimension lines 
will also change the colour of your notes. 
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Fig. 37 - Examples of dimensioning the wardrobe model – Dimension menu 

 
 

  - ‘2D view’ - switch to a 2-dimensional mode, 
the orthogonal projection of the front of the wardrobe 
model, without being able to rotate the camera (you can 
only move it vertically up/down and left/right, and zoom 
in/out) (black icon - disabled, orange icon - enabled). 
 

  - ‘3D view’ - displays 3-dimensional space, 
where you can freely rotate the camera and view the 
wardrobe model from all sides and angles (orbital mode); 
this is the default mode in the Wardrobe Module. 
 

 - ‘Options’ - opens the ‘Display options’ window, 
where you can set the opacity of options windows and 
choose a background colour and lines visible in the 
wardrobe design visualisation (Figure 38). 
 

 - ‘Save picture’ - opens the ‘Saving...’ window (Fig. 
39), where you can change the settings of the saved 
image: including: 
 camera position (current or default); 
 type of view (normal or exploded); 
 dimensions of the image saved; 

 
Fig. 38 - Display settings 

 

 
Fig. 39 - Illustration saving options 

 selection of the area to be presented in the picture (whole wardrobe or only 
selected parts); 

 visibility of the various elements: walls, doors, notes and dimension lines, 
modules; you can also save the view in linear form; 

 background colour of the print; 
 a variety of picture file formats can be selected from. 
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The illustration beside presents an exem-
plary picture of a wardrobe generated in 
the ‘exploded’ view (Fig. 40). In this mode 
you can clearly see all components of a 
design. 
 

 - ‘Default view’ - rotates the camera 
and sets it in the default position. Helpful 
when you uncontrollably zoom out. 

 
Fig. 40 – Exemplary exploded view  

 

  - ‘Pull out drawers’ - this option becomes active when you select one or 
more drawers or accessories (pull-out shelves or baskets) by clicking on them. It moves 
them forward by a default value. Pulling out the selected elements is not possible if 
they collide with the door (which needs to be moved or removed in such a case). This 
option useful for creating interesting visualizations in our CAD programs (Fig. 41). 
  

 
Fig. 41 – Example visualization created in CAD Decor PRO – drawers pulled out   

4.5. ‘Options’ tab 
 

In this tab you will find advanced designing features associated with the processing of 
the material (‘Dimension allowance’ and ‘Expected panel thickness’), three editors 
(for the price-list, drawers and fronts) and options of user and standard modules. 
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 - ‘Machining allowance’ - allowance is the 
layer of material removed during the processing. 
The size of the final allowance is determined by 
the difference of workpiece dimensions before 
and after processing. Wardrobe Module makes it 
possible to determine the amount of excess 
material for various wardrobe elements (Fig. 42). 
After setting these values they will be added to 
the price of the individual elements. 
 

 - ‘Expected thickness of boards’ - dimensions, 
which determine what should be the thickness of the 
given panel. For example, if you change the thickness 
of the side panels here, during the later edition of the 
side panel in the design, the first choice will be the 
panels with the thickness specified here (Fig. 43). If 
you select ‘Do not display this window again’ in both 
of these windows, they will not be showed when 
running a report (report generation function, i.e. list 
of wardrobe components and their prices, available in 
the last tab of the ‘Summary’ sidebar). 
 

 - ‘Price-list editor’ - opens the producer's price-
list (Fig. 44). 

 
Fig. 42 - Setting the allowance 

 

 
Fig. 43 - Defining the desired thickness 

of the boards 

 

 
Fig. 44 – Price-list editor 

 
The items in the price-list can be filtered using the icons on the left side of the window 
(‘Panels’, ‘Longitudinal elements’, ‘Profiles’ and ‘Other elements’). Four positions are 
available for editing: ‘Currency’, ‘Sale price’, ‘Net/Gross’ and ‘VAT’ (Fig. 45). 
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To change any of these 
items, left-click on the edit 
box. For columns ‘Currency’ 
and ‘Net/ Gross’, a drop-
down list will appear, from 
which you can select a 
different value.  
 
In the ‘Sale price’ and ‘VAT 
[%]’ columns you can 
manually enter a new value 
(Fig. 45).  

Fig. 45 - Editing a price list item 

 - ‘Drawer editor’ - selecting this icon opens the ‘Drawer model database editor’ 
window, where you can change the default drawer settings and add any number of 
custom drawer models. Detailed description in section 4.5.1. below.  
 

 - ‘Sliding door editor‘ - opens a window divided into four tabs: ‘Editor’, ‘Set’, 
‘Graphics’ and ‘Materials’. In here you can: add door divisions, set the number of 
tracks and their order, choose the parameters of the door set and apply selected 
graphics or materials on parts of door leaves. 
 

- ‘Module options’ - here you can 
change the folder for saving your 
modules, choose another directory 
from which standard modules available 
in the database will be loaded or delete 
all saved user modules (Fig. 46). For 
more information about the modules 
please see point 5.5. on page 46.  
 

 

 
Fig. 46 - Module options 

4.5.1. Description of the ‘Drawer database editor’ 
 

The editor allows you to change the parameters of existing drawers and to add new 
models. The changes to the settings are displayed in real time in the preview, which 
can be rotated by 180° with a slider located below it. In the preview, the outline of a 
hypothetical cell in which the drawer will be placed (grey lines) and the currently 
edited dimension are highlighted (e.g. the distance between the drawer case and the 
sides of the cell - orange lines visible on Figure 47 on the next page).  
The indicated dimensions may change during insertion of a drawer into a wardrobe, 
because in most cases drawers automatically adjust to the shape and size of the cells in 
which they are placed (so if the depth of the drawer is set to 1000 mm, and the depth 
of the wardrobe is 700 mm, the depth of the inserted drawer automatically changes to 
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700 mm). The exception to this rule is insertion of drawers with a fixed height, 
specified in the editor (so-called ‘blocked’ drawers). For more information see page 46. 
 
Therefore it is much more important to properly set the values of offsets between the 
particular parts. Especially important are settings listed below (and marked on Fig. 47): 
 upper, lower and side margins - the distances between the drawer front and side 

walls of the cell, in which the drawer is inserted; 
 the difference between the width of the drawer case and the width of the cell (the 

dimension is marked on Fig. 47); 
 the difference between the length of the slider and the length of the drawer case  

(option ‘Depth difference’ in the ‘Case’ pane); 
 it is also vital to select sliders of a proper length (note! the depth of the drawer 

case depends on the length of the sliders); 
 and to set distance between the bottom of the drawer and the bottom of the cell 

(option ‘Bottom level’) and its offset from the bottom edge of the drawer box.  
 

 
Fig. 47 - Drawer model database editor 

 
4.5.1.1. Icons in the ‘Drawer database editor’ window 

There are three icons in the editor:  ‘New drawer’  ‘Copy drawer’ and  
‘Delete drawer’.  
To start designing a new drawer, click on the first icon. In the list in the upper left 
corner a subsequent item will be added, with default parameters and name, which can 
be freely changed. To make a copy of an already existing drawer, select the second 
icon - then a new item with the parameters of the original one will be added to the list. 
To delete a drawer, select it in the list and click the third icon.  
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4.5.1.2. Functions of the ‘Drawer database editor’ window 
 List of drawers - in the upper left corner; and all models 

are available in the expanded list (Fig. 48). 
 ‘View parameters’ panel - sets the width, depth and 

height of a hypothetical cell; the pane can be collapsed 
by clicking on the  (similarly to the other panels). 

 
Fig. 48 - List of created drawers  

 ‘General’ panel - you can specify a name for the drawer model created; 
 ‘Front’ panel - here you can determine the difference between the height of the 

drawer and the hypothetical cell in which it is placed, i. e. the space between the 
drawers (in ‘Upper margin’ and ‘Bottom margin’ boxes), as well as the size of the 
gap on fronts sides (‘Side margins’). You can also select the material, edging and 
grain of the front. 

 ‘Case’ panel - here you can determine the relative position between parts of the 
drawer (options ‘Full height...’, ‘Bottom beneath...’) and set distances between 
them (options ‘Difference...’, ‘Level...’, ‘Offset...’). You can also decided, whether 
an additional board at the front of the drawer case should be inserted (Figures 49 
and 50).  
 

 
Fig. 49 - creating a new drawer - with additional case front board 
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Fig. 50 - - creating a new drawer - without additional case front board 

 
 ‘Sliders’ panel - here you can add any number of sliders that are available in the 

database to the list available to the given drawer and choose a slider of an optimal 
length for the edited drawer. 

 ‘Handles’ panel - you can choose the handle model and determine the offset of the 
handle from the edges of the front and their number (0, 1, 2); 

 ‘Price’ panel - here you determine the cost of installation as a percentage (Fig. 51). 
 

 
Fig. 51 - Drawer editor - creating a new drawer - collapsed ‘View parameters’, ‘General’, ‘Front’ and ‘Case’ panels  



                

                                  

30 

 

4.5.2. Description of the ‘Sliding doors editor’  
 

 - ‘Sliding door editor‘ - the fifth icon of the ‘Options’ tab in the top menu opens a 
window with four tabs: ‘Editor’, ‘Graphics’, ‘Set’ and ‘Materials’. Functions available in 
these tabs are described in the following sections of this manual. 
 
4.5.2.1. Functions of the ‘Editor’ tab 
 

In the ‘Editor’ tab you can add, edit, modify, copy and delete divisions of door leaves. 
Divisions can be straight or arc and go through any number of door leaves in any 
directions. They cannot intersect - when you add a division that goes across an already 
existing one both lines will disappear. A detailed description of the procedures of 
adding and editing divisions can be found on the following pages.   
 
In the ‘Editor’ tab you also can change the track on which the particular door leaf 
moves. Clicking on the yellow lines in the bottom of the window with the left mouse 
button gives access to a context menu where you can select the track:    
(Fig. 52). This way you can determine which door leaf is to be placed on the outer track 
(1), and which on the inner track (2).  
 

 
Fig. 52 - Sliding door fronts editor - Editor tab 

 

 
For assistance, you can turn on the background grid with any width (options ‘Grid’ and 
‘Grid width’ in the lower left corner of the window). To navigate in the door editor use 
the mouse. To zoom in or out use the scroll wheel. To move the view, press and hold 
the right mouse button and move the mouse in the desired direction. To select objects 
use the left mouse button. Selected objects are highlighted in pink, and in case of 
division lines also the end points and arc middle points are also be marked.  

Note!  
 

Door divisions 
cannot cross.  
 

Their collision 
will result in 
disappearance 
of both division 
lines. 
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After selecting an object is possible to expand the context menu under the right mouse 
button (Fig. 53).  
 
To insert a division line, click the ‘Straight division’ button and define its localization 
with two consequent left-clicks. To add a division to a particular door leaf, it must pass 
through it in its entirety - the intersection of the leaf boundary by the dividing line is 
marked with a dark blue cross X (Fig. 52 above on the previous page). In order to add a 
curved division, click on the ‘Arc division’ button and click in the point, which will 
define the centre of the circle. Then define its size by moving the mouse. The result is 
an arc division which consists of segments of a circle (Fig. 53). 
 

 
Fig. 53 – exemplary arc divisions  created by using the ‘Arc division’ function  

 
Fragments of divisions located 
on separate leaves are subject to 
independent edition (Fig. 54). 
Areas separated by the divisions 
are also independent, so various 
graphics and materials can be 
applied to them (Fig. 54).  
 
New arcs can be added to 
inserted divisions – using the 
‘Add arc’ option in the context 
menu, under the condition that 
the angle of the edited arc does 
not exceed the permitted value.   

Fig. 54 – example of use the curved divisions, created with  
the ‘Arc division’ option and by adding arcs to straight divisions 

 
 
1 
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On the following pictures you 
can see various stages of work 
with the sliding door editor. 
 
Dependant on the angle of 
the arc, the context menu 
includes various options. Each 
arc can be reversed (Fig. 55). 
 
When the option ‘Single point 
edition’ is enabled (Fig. 55), 
you can modify the shape of 
the division using its marked 
edition points.  You can see an 
expanded and previously 
reversed arc on Figure 56. 
 
Division lines to which a few 
arcs were added have many 
edition points (Fig. 57).  
 
Location of these points can 
be freely changed, using ‘drag 
and drop’ method. To do it, 
left-click on the point you 
want to move, and then, 
holding the left mouse button 
down, move the cursor, and 
when the arc reaches the 
desired shape - release the 
button. 
 
As you can see on Figure 57, 
the current height is displayed 
for the end points, to 
facilitate adjusting the ends of 
separate divisions, located on 
different leaves.  

 
Fig. 55 – using the ‘Reverse’ option 

 
 

 
Fig. 56  – changing the shape of an arc using its central point  

 
 

 
Fig. 57 – marked division with many edition points 

 

 

Note! It is not possible to create 
a circular division within only 
one door leaf. 
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Fig. 58 – disabled ‘Single points edition’ function  

 

 
Fig. 59 – the arc division moved downwards  

 

 
Fig. 60 – deleting an arc division 

When the ‘Single point 
edition’ option is disabled 
(Fig. 58), then the edited 
fragment of a division 
maintains its shape. It is 
then possible to move it 
up and down, ‘dragging’ it 
by edition points (Fig. 59).  
 
For your convenience we 
have added the ‘Undo’ 
and ‘Redo’ buttons in the 
door editor.  They enable 
you to quickly and safely 
check various ideas and 
cancel them if necessary. 
You can also use keyboard 
shortcuts which can be 
defined in the ‘Help’ tab, 
the last tab in the top 
menu (for more 
information please go to 
page 36). 

 
The ‘Straighten’ option is 
available for arc divisions 
with appropriate angles. It 
is not possible to 
straighten an arc which 
has both end points on 
the same leaf boundary 
(Fig. 59).  
Divisions can be deleted 
in a few ways (Fig. 60):  
 only the selected divi-

sion (‘Delete’ option 
in context menu),  

 all divisions from a 
particular leaf (‘Clear 
leaf’ in context menu),  

 all divisions from the 
entire design (‘Clear 
divisions’ button in 
the editor side panel). 
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Fig. 61 – copying a division of a complicated shape 

 

 
Fig. 62– pasting the copied division to another door leaf  

 

 
Fig. 63 – the result: the twin division at the same level as the original one 

 
Divisions can be also copied 
(Fig. 61). A copied division 
can be pastel in the same or 
another door leaf, if there is 
no collision with an existing 
division (Fig, 62). The copy 
will be inserted on the 
same level as the original 
division (Fig. 63). 
 
To be able to insert two 
identical divisions at various 
levels on the same door 
leaf, copy the original first 
and then drag it to the 
desired level, and then 
paste the copy - it will be 
inserted on the level on 
which the original has been 
located at the moment of 
copying. 

 

 

 

 
 

Note! After selecting the ‘Add 
arc’ option a new arc will be 
added. Move the mouse to 
see the change on the 
preview.   

Note! During the edition of 
divisions it is necessary to 
precisely click on lines and 
marked points.  

Note! After completing the 
edition of a division, before 
you edit another item, you 
should  unselect the edited 
division by pressing [Esc] key 
or using the ‘Unselect’ option 
in the context menu. 
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4.5.2.2. Functions of the ‘Graphics’, ‘Set’ and ‘Materials’ tabs 
 

 The ‘Graphics’ tab (Fig. 64) enable you to place your own 
graphics on doors from any location on your computer. After 
selecting a leaf or a section of the front, separated by the 
division lines, select the ‘Select graphics’ icon ,  find a 
JPG file on your computer and select it by clicking it and then 
pressing the ‘Open’ button. Texture will be applied to the 
indicated leaf or section. You can select more than one 
section of the door (e.g. two fronts), then the same graphic 
will be applied to all selected items. If no leaf is selected at 
the time of selection of the texture, it will be applied to the 
entire door. 

 

 

 
Fig. 64 - Front editor 

– ‘Graphics’ tab 
 

Applied textures can be arranged in tiles (‘Tiled’ option), spread separately on each 
leaf (‘For leaves’ option) or on the entire door (when none of the above options is 
selected). You can also scale them in X and Y axes (horizontally and vertically). 
 
 The next tab in the ‘Sliding door editor’ is ‘Set’. If the storage 

shelf divides the wardrobe doors, you can choose the main 
door and the storage door using buttons: . 
You can set the number of leaves (separately for both sets), 
the number of tracks for the door (there is one double track 
by default), and the amount of the upper and lower reserve 
(Fig. 65). The reserve determines how much free space is 
above and below the door leaf. This is important when 
choosing hardware and in the case of uneven floor and 
ceiling. In the program you can determine the maximum and 
minimum value of the reserves for the selected door system.  

 

 
Fig. 65 - Front editor - 

‘Set’ tab 

 
By default in the Wardrobe Module there is 
one double door track. More tracks can be 
added in the door editor in the ‘Set’ tab, as 
well as in the ‘Construction’ tab in the side 
panel, using the ‘Door’ button and the 
‘number of tracks’ option. 
 
To add a track first you have to increase the 
space provided for the door. To do it: 
- close the door editor and go to first tab 

in the side panel ‘Recess’, 
- click the ‘Recess dimensions’ button and 

in the new window change the value of 
the ‘width of the door space’ (Fig. 66), 

 
Fig. 66 – setting the width of space provided for door 
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- confirm changes by clicking ‘Ok’.   
 

 The last tab in the front editor is ‘Materials’ (Fig. 67). There are several types of 
materials available here: ‘Boards’, ‘Mirror’, ‘Glass’, ‘Rattan’, ‘Bamboo’. To apply 
them to the fronts, use the ‘drag and drop’ method:  
- click on the selected material with the left mouse button,  
- holding the button, move the cursor over the chosen part of the door, 
- release the button - the texture will be applied to the indicated fragment. 
 

 

You can also select one or 
more of the door areas by 
clicking on them, and then 
select the material - it will be 
applied to the selected areas. 
 
The applied materials are 
displayed in the visualisation 
in the CAD Decor, CAD Decor 
PRO and CAD Kitchens 
programs.  
 
 
4.6. ‘Help’ tab 
 

The last tab of the top menu 
contains three icons: ‘About 
the program’, ‘Keyboard 
shortcuts’ and ‘Help’: 

 

                      
Fig. 67 - Sliding door editor – ‘Materials’ tab - various types of materials 

 

 - ‘About the program’ - displays 
the window in which you can find the 
version number of the module and 
the manufacturer (Fig. 68). 
 

 - ‘Keyboard shortcuts’ - this 
feature allows to check the currently 
set shortcuts and to define your own. 
Figure 69 on the next page shows an 
exemplary system of shortcuts. To 
define your own shortcut, click on the 
chosen item and then select the key 
or combination of keys, such as X or 
[Ctrl + Y].  
 

 
 

 
Fig. 68 - Information about Wardrobe Module 
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Thanks to the ‘Keyboard shortcuts’ 
function, the Wardrobe Module can 
become your personalised tool. Some 
shortcuts, such as undoing the last 
operation, are set by default in the 
module ([Ctrl + Z]). However, they can 
be changed accordingly to your will. 
 

 - ‘Help’ - this button opens the 
module operation manual in PDF. 

 
5. Functions in the side panel 
 

5.1. Introduction 
 

The panel on the left side of the screen 
contains 6 tabs in which options related 

 
Fig. 69 - Window for defining keyboard shortcuts 

related to various aspects of wardrobe design are available: ‘Recess’, ‘Construction’, 
‘Elements’, ‘Modules’, ‘Materials’ and ‘Summary’. Here you can:  
 change the dimensions of the recess into which the wardrobe is being fitted (note: 

this will not change the size of the recess in the design in a CAD program);  
 add  bevels, distances between recess walls and parts of the wardrobe, set storage 

options, change the width of the door space, 
 edit individual components of the wardrobe (floor, ceiling, walls, back, door);  
 insert accessories (partitions, drawers, rods, pantographs, etc.); 
 use ready-made modules of accessories, included as standard in the database or 

custom, for example, a set of shelves or drawers, ready to be inserted; 
 establish specific materials for all parts of wardrobe and door; 
 make a summary of the wardrobe design - a list of errors and reports containing a 

list of the used components and their price. 
 
5.2. ‘Recess’ tab 
 

Only one button is available in this tab - ‘Recess size’: 
 

 

‘Recess dimensions - here you can define or change the dimensions of 
the recess (which may already be set in the ‘Basic Options Wizard’ or 
by default be loaded from the shape of the walls drawn in CAD - except 
for the depth, which by default is set to 670 mm). 
 

When setting the default depth, the average depth of accessories (450 mm), the 
space for the door and the margin and width of the wardrobe back were taken into 
account. The default depth can be changed and customised to your needs, also 
separately for the left and right sides of the recess (this option is useful in case of 
bevelled recesses). 
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The ‘loaded’ option in upper right 
corner allows you to decide 
whether wardrobe’s width and 
height are to be read and loaded 
from the shape of walls in CAD 
program, or set manually. 
 
Beside the basic dimensions, you 
can also set the recess side bevel 
parameters, the distance 
between the recess and the 
wardrobe, location of the storage 
space, the width of the door 
space and refraction by which all 
shelves are set back in relation to 
the partitions (offset into the 
wardrobe) and refraction of 
additional shelves in relation to 
main shelves (Fig. 70).  
 
 
5.3. ‘Construction’ tab 

 
Fig. 70 - Window with recess parameters 

This second tab of the left side panel contains five icons: ‘Wardrobe base’, 
‘Wardrobe top’, ‘Walls, ‘Back’, ‘Doors’. 
 

 

‘Wardrobe base’- opens the ‘Wardrobe base’ window in which you can 
set options for the inclusion of a floor and base (‘floor present’, ‘plinth 
present’, ‘full floor’) and their parameters. Your settings will appear on 
the preview in the visualisation. 

 
 

You can also determine which edge of the 
floor or base to be veneered. To do so, select 
the appropriate item on the left side of the 
window (‘floor’ or ‘plinth’) and check the 
appropriate box on the schematic preview of 
the currently selected element (Fig. 71). Then 
you can switch to the second element, and 
also define its edges where veneer should be 
added. 
 
If the element has not been defined as 
included in the design (by selecting options 
‘floor present’ and ‘plinth present’), its 
diagram will not be displayed. 

 
Fig. 71 - Selection of veneered edges  
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‘Wardrobe top’- this button opens the ‘Wardrobe top’ window in which 
you can decide on the inclusion of the roof or ceiling in the design, and to 
determine the size of the lowering, the depth of the ceiling (how far it 
reaches into the wardrobe) and how much the ceiling is pulled out (how 
far it extends beyond the front of the wardrobe). 

 
Here you can also insert lighting in the wardrobe ceiling. To do this, pull out the ceiling 
to the front of the wardrobe for a minimum of 100 millimetres, and then select the 
‘ceiling lighting’ box. You can set the number of halogens and their distance from the 
edge of the ceiling, and the program automatically places them at equal distances from 
each other on the ceiling. Inserted halogens and any changes in their number and 
location are visible in the preview (Fig. 72). You can choose different from types of 
halogens in the drop-down list at the bottom of the window.  
 
Halogen inserted into the wardrobe model are shown in the CAD environment and in 
the visualisations in CAD Decor PRO, CAD Decor and CAD Kitchens. Working with the 
visualisations in these programs you can select their parameters (intensity, range, the 
angle of the cone, the shape of light generated, stored in IES files), just as all other light 
sources in the design.  
 
For more information on how to edit halogens, please refer to the user manuals for 
the CAD programs that are to be found in the installation location of the software (in 
the ‘manuals’ folder), or can be downloaded from our website in PDF format. 
 

 
Fig. 72 - Halogens inserted in the extended wardrobe ceiling 

 

 

‘Walls’ - when you select this button you can define the colour and the 
parameters for the walls and filler strips (Figures 76 and 77). To switch 
between the different elements use the buttons at the top of the 
window.  
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Walls can be eliminated 
from the design by 
unselecting the 
‘present’ box (Fig. 73), 
and the filler strip - by 
selecting the ‘no filler 
strip from the ‘type’ 
drop-down list (Fig. 74). 
 
You can determine the 
following dimensions of 
filler strips: width (100 
millimetres by default) 
and depth (this is: how 
far a filler strip reaches 
into the wardrobe). 
 

 

          
                   Fig. 73 - Editing walls                          Fig. 74 - Editing filler strips 

It is also possible to define colours of boards and edgings and indicate, which edges of 
each board are to be veneered. In the case of an angular filler strips, veneered edges 
can be defined separately for both parts of the panel (front and lateral) – to switch 

between them use the buttons on the left side of the window:  and .  
 

 

‘Back’ - with this button you can change the settings for the back of the 
wardrobe. You can completely remove it from the design (‘present’ box), 
or to decide whether the storage shelf and partitions are to divide the 
back, or should it be maintained solid (Fig. 75). 

 

 
If you decide that the partitions should divide the 
back of the wardrobe, then the individual panels 
appear in the ‘Width of elements’ list. When you 
click on each of them, their width will appear on 
the right (Fig. 75). 
 
The width of these panels is determined by the 
position of partitions and the storage shelf and 
therefore cannot be changed. 
 

 

 
Fig. 75 - Defining settings for the back 

 

 

‘Doors’ - enables you to decide, whether doors will be present in the 
design, and to select their options: a type (sliding or opening), a number 
of leaves and tracks, an upper and lower clearance (the maximum value 
depends on the database used), an offset from the side panels and the 
width of the leaves.  
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The door may be divided into two parts by the 
storage space (functionality available in the Basic 
Options Wizard - Step 2: ‘Storage main shelf divides 
the door’ option - see pages 16 and 17). In that case 
in the ‘Door set’ window you will see two tabs: 
‘Main set’ (referring to the bottom door) and 
‘Storage set’ (for the upper door).  
 
By default the width of all door leaves is identical. 
However, you can change it independently for each 
leaf. To do it, uncheck the ‘Automatic’ box by the 
‘leaves width’ option, select the leaf to be edited 
and enter the desired value in the box on the right - 
by typing it or using the  buttons (Fig. 76).  
 

 

 
Fig. 76 - Setting the new width of the leaf 

To refresh the view and see the result of the change, click any other edit box.  
 

 
 

After selection the ‘Opening doors’ option from the 
drop-down list, the layout to the ‘Door set’ window 
and available options change (Fig. 78 on the next 
page). You can define leaf margins and materials, as 
well as presence, number and model of hinges. 
 
A similar window called ‘Opening doors’ (Fig. 78) 
will open when you edit an opening door present in 
the design (by right-clicking and selecting the ‘Edit’ 
option from the context menu). In here you can also 
select a model of a handle and its offset from the 
side and bottom edge, and indicate edges to be 
veneered too. 
 
Opening doors automatically adjust to cells created 
by partitions in the main and storage parts. For 
example, if a wardrobe has 3 partitions, then 3 
leaves of opening doors will appear.  
 

 

 
Fig. 77 – options in the ‘Door set’  

window for opening doors  

If you decide to add another partition after already inserting the opening door, then 
the new cell with be inserted without a door. If you remove all door leaves and insert 
them again, the number of inserted leaves will be equal to the number of existing 
compartments created by partitions.   

Note! Please remember that other options for doors (e.g. divisions, setting the number of leaves) 
are available in the top menu: in the ‘Options’ tab, under the ‘Sliding doors editor’ icon. 
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The width of opening doors depends on the 
width of cells for which they are inserted. If the 
main partitions are moped, then the width of 
the door leaves will adjust to new width of cells.  
 
In case of opening doors each leave can be 
separately removed (option available in the 
context menu after right-clicking on the door 
leaf - Fig. 79).  
 

 
Fig. 79– context menu for opening doors 

 
To remove all leaves of opening doors at one 
time, click the ‘Door’ button in the 
‘Construction’ side pane and in the ‘Door set’ 
window select ‘No door’ position from the drop-
down list (Fig. 80).  

 

 
Rys. 78 – edition of opening doors  

 

 
Fig. 80 – removing opening doors 

5.4. ‘Elements’ tab 
 
 

 

‘Select many’ - allows you to simultaneously select multiple elements of 
the wardrobe. Selection is displayed as a red rectangular outline (in the 
case of the components of the wardrobe) or pink filling (in the case of 
dimensions of the cells).  
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‘Partition’ - clicking on this icon expands a list of available partitions: 
‘main’ and ‘additional’. To add a partition, click the icon and click on the 
cell in which the partition should appear. Partitions are automatically 
arranged symmetrically in the dimension of the cell (you can then move 
them). To place them exactly where you want, hold down [Shift] while 
inserting. To stop inserting, select the [Esc] key or click anywhere with 
the right mouse button.  
 

 

 

‘Shelf’ - used to insert shelves; clicking on the icon expands a list of shelf
types: ‘main’ and ‘additional’. The same as partitions, shelves are 
inserted at regular intervals, but you can move them (or use the [Shift]
key when inserting). [Esc] or the right mouse button ends the operation. 

 
 

 
 

 

‘Drawer’ - enables you to place drawers in the wardrobe. A default 
model or one recently added to the drawer editor is inserted. Insertion 
of drawers can be performer in two ways: by proportional filling the 
entire cell or with maintaining the height of the drawer set in the drawer 
editor. It depends on the type of used shelves (see: frame above).   

 

 If there are only main shelves in the design, then the first inserted drawer will use 
the entire space available in the cell (its size will accurately adjust to the size of the 
cell). Each time another drawer is inserted to that cell, the existing ones will be 
automatically proportionally adjusted.  

 
In this case the possibility of inserting drawers to the 
particular cell will end when the next division would 
result in insertion of drawers less than 150 mm high. 
In that case you will see a message ‘The cell is too 
small…’ (Fig. 81).   

Fig. 81 – Information that 
 no more drawers can be  

inserted in a particular cell  
 

 

 If additional shelves have been inserted in the cell, then drawers will insert with             
a fixed height, which has been set for them in the drawer editor or in the database. 

Note! Below we present characteristics of main and additional partitions and shelves:  
- additional elements are shorter and distance between them and doors is greater,   
- inserted main shelves are automatically arranged in the cell in equal distances (the exception is the 

situation when the user is pressing the [Shift] key during the insertion);  
- if additional shelves are inserted after the main ones, it the main one will not change their location, 

but the additional ones will be equally spread in the space between the main shelves,   
- main shelves cannot be added to the additional partitions, 
- using an additional shelf results in inserting drawers with the height which was defined for them in the 

drawer editor, and not filling the entire cell, 
- main and additional shelves behave differently after using the ‘Distribute evenly’ function: the 

program will distribute the main shelves in equal distances in relation to the main cell, and additional 
shelves will be distributed proportionally in the inferior cells between the main shelves. If only one type 
of shelves is used, they will be all equally spaced.  
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Inserted drawers can be edited and replaced with others. To do it, left-click to select               
a drawer and then right-click to develop the context menu, and choose the ‘Edition’ 
option. As a result the ‘Drawers’ window will open (Fig. 82).  

 
In this window you can: 

 

- change drawer’s height, 
- select another model from the drop-down list 

‘drawer diagram’ in the ‘Construction’ pane, 
which contains models existing in the database 
or created by you in the ‘Drawer database 
editor’ (see point 4.5.1 on page 26), 

- select another slider or materials for board 
and edging of the drawer front, 

- change the type and quantity of handles, 
- set a new value of the offset inside the cell 

(the distance between the drawer front and 
doors), 

- define veneered edges for the front, back, 
sides and bottom of a drawer. 

 
 

 
Fig. 82 – Editing drawers 

 
When editing drawers, in the context menu you 
will also see a ‘Block drawer’ function (Fig. 83). 
It enables you to maintain constant height of the 
inserted drawer, so it is no longer proportionally 
adjusted when a new drawer is added. To use it: 
- stop inserting drawers by clicking [Esc] or the 

right mouse button,  
- select a drawer with a left-click,  
- in the menu under the right mouse button 

choose the ‘Block drawer’ option (Fig. 83).  
 

From this moment the height of this particular 
drawer will not change during insertion of the 
subsequent drawers in this cell (Fig. 84).  
 

 
 

The height of a drawer can be also blocked 
during the edition of a drawer, by just setting a 
desired height in the ‘Drawer’ window and 
saving changes by clicking ‘Ok’ .  

 
Fig. 83 – Blocking drawers 

 

 
Fig. 84 – Resulting blocked drawer 

 

Note! In the situation described above all new 
drawers are inserted above the blocked drawer. 
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‘Rod’ - clicking on the icon expands a list of available rods: ‘vertical’, 
‘transverse’ and ‘longitudinal’ (i.e. running across the wardrobe from the 
back to the door). The joints between the horizontal and vertical rods are 
not visible in the preview of the wardrobe, but are included in its price. 

 

 

‘Accessories’ - allows you to insert the accessories provided in the 
database to the wardrobe, e.g. baskets (for laundry, sorters, wire baskets) 
(Fig. 85), pull-out elements on sliders, shelves and shoe racks and other 
(e.g. hangers for belts , ties and clothing).  

 

 
Fig. 85 - Inserting a basket 

 
The selection of accessories is made in a new window by clicking on the ‘Accessories’ 
icon. When inserting accessories, you can switch between the various elements. To 
end the operation click [Esc] or the right mouse button. 
 
Inserted objects can be moved and 
edited, their dimensions changed or 
can be replaced for another model. 
 
When you edit a pull-out shelf, you 
can also select the board and the rim, 
as well as the slider (Fig. 86).  
 
You can use the mouse to move 
inserted accessories upwards and 
downwards. You can also pull them 
out to the front of the wardrobe, 
using the ‘Pull out’ option available 
under the right mouse button.       

Fig. 86 - Editing pull-out shelves                                  

 

 

‘Pantograph’ - a collapsible hanger consisting of movable arms and a 
long handle, allowing it to move down and back up; used in high 
wardrobes in which it is difficult to reach the hanger; inserting the pull 
down hanger requires the fulfilment of several conditions - the cell must 
be the correct width and rods cannot be inserted in it. 
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‘Empty cell’ - inserts a cell with a specific, fixed shape, marked with a red 
cross, which will remain empty. It will not be possible to insert any 
element in such a cell - until removing the marking of an empty cell. 
 

 

 

‘Note’ - to insert a note, click on the element concerned, determine the 
location of the entry, enter text in the ‘Note’ window and confirm it by 
pressing ‘OK’. To insert a note without a frame, clear the  ‘frame’ check-
box. Width of the note can be set using  buttons. Text size in the 
note is not editable. Its colour, however, can be selected in the 
‘Dimensions menu’, available under the eighth icon in the ‘View’ tab in 
the top menu of the module).  

 
5.5. ‘Modules’ tab 
 

 

 

‘Standard’ - displays the ‘Standard modules’ window, which has a list of 
modules available in the database - along with their names and previews 
that can be hidden by unselecting the ‘Names’ and ‘Previews’ boxes (it is 
impossible to unselect both at the same time). After clicking on the
‘Standard’ icon the wardrobe doors are automatically hidden to allow 
the insertion of modules. To restore their visibility, go to the ‘View’ tab 
in the top menu and click the ‘Door’ icon. 
 

The module can be inserted into the cell in several ways: 
 Select the cell by clicking (Figure 78), then select the ‘Standard’ icon and select the 

module from the list - at this point it is inserted into the selected cell (Fig. 87); 
 Select the module first, click the ‘Insert’ button and then click again to indicate the 

cell where you want to place the module - it will be inserted; 
 Drag-and-drop a module from the list to the cell where you want to insert it. 

 

 
Fig. 87 -  Selection of a standard module to be inserted 
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Modules automatically adapt to sizes and shapes of cells they are inserted into. If it is 
impossible to scale elements (e. g. indicated cell is too small), you will be informed  
(the following message will appear: ‘Some elements are too large  to copy them’).  
 

 
Fig. 88 - Module inserted in the indicated cell 

 
 

 

‘User’ - this icon gives access to the user-designed modules. To save your 
own module, after you insert all desired elements in a cell, select it), 
open the context menu with a right-click and select the ‘Save module’
option. Saved modules can be used in future designs, which is a great 
convenience and significantly speeds up your work.  

 
 

5.6. ‘Materials’ tab - selecting and saving colour schemes 
 

 

5.6.1. Selection of colour schemes for the interior and exterior of the wardrobe 
 

 

 

‘Wardrobe’ - by selecting this icon you can set the colours for the entire 
wardrobe (with the exception of the door), separately for the exterior, 
interior and drawers (in the tabs of the same name) and choose other 
elements (in the ‘Other’ tab) (Figures 90, 91, 92 and 93).  

Here you can also save new colour schemes that can be selected in the ‘Basic Options 

Note! Clicking again in the same place increases the range of selection by one level of division. In 
other words: it causes marking the superior cell. (Fig. 89). 
 

 
Fig. 89 – Increasing the range of selection by consequent superior cells (from the left: 1 click, 2, 3 and 4 clicks)  
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Wizard’ in your future designs. 
 
The wardrobe exterior consists of: side and back walls, filler strips, floor, plinth, 
support, ceiling, roof, and lowering (Fig. 93). Interior elements of the wardrobe are: 
partitions (main and additional) and shelves (main, additional, storage) (Fig. 94). In the 
‘Drawers’ tab you can specify: the drawer scheme (default or user-defined), board and 
edging of the drawer front, handle type (Fig. 95). You can also define: halogens, brush 
pile seals and a buffer strip silencing the door - in the ‘Other’ tab (Fig. 96). 
 

                   
        Fig. 90 - Defining the colour scheme for the exterior          Fig. 91 - Selection of colours for the interior of the wardrobe 
 

          
Fig. 92 - Selection of colours for the drawers                  Fig. 93 - Selection of the scheme for other elements 

 
5.6.2. Saving your own colour schemes for the interior and exterior of the wardrobe 
 

When you define a colouring for the wardrobe you can save your own colour schemes. 
They will be available when you create a new wardrobe design in the fifth step of the 
‘Basic Options Wizard’: ‘Schemes and Materials’. It will be also available after 
proceeding to the ‘Materials’ tab, discussed in this section, and selecting the 
‘Wardrobe’ button, in the ‘Wardrobe materials’ window (new scheme added to these 
lists is presented in the illustrations on the next page - Figures 97 and 98). 
To create your own colour scheme: 
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 go to ‘Materials’ tab in the left side panel and click the ‘Wardrobe’ button, 
 in the ‘Wardrobe materials’ window, select the tab that will determine the type of 

scheme you create:  ‘Exterior’ and ‘Interior’; 
 specify the colour for each element of the exterior or interior of the wardrobe, 

selecting it from the drop-down lists in the ‘Colour scheme’ panel; 
 then click the  ‘Save scheme’ button  

in the ‘Colour scheme’ panel (Fig. 94); 
 the ‘Colour’ field containing the name 

of the scheme will be then edited; 

 
 

 
Fig. 94 - Naming your colour scheme 

 enter the name for the created scheme in the ‘Colour’ field (Figures 95 and 96);  
 

  
   Fig. 95 - Selection of ‘Save scheme’ button -  name edition                Fig. 96 - Entering a name for the new scheme 
 
 confirm the new name by pressing [Enter] - then the new colour scheme will be 

added to the list in the ‘Wardrobe materials’ (Fig. 97);  
 a colour scheme created this way is added to the database and to the list in the 

‘Schemes and Materials’ window, available in the fifth step of the ‘Basic Options 
Wizard’ (Fig. 98); 

 

                       
     Fig. 97 - After confirming the new name is added to the list                Fig. 98 - New scheme in the Basic Options Wizard 
 
To add your own settings templates follow analogical procedure. They can be created 
for the above two tabs, as well as for the ‘Drawers’ and ‘Other’ tabs. To do this: 
 after changing the parameters, click the  ‘Save scheme’ icon in the ‘Settings 

template’ panel - an edit box for the template name will then open; 
 enter the name and confirm by pressing [Enter]; 
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 new template is saved and will now be available on the list in the wizard and in the 
‘Wardrobe materials’ window. 

 
5.6.3. Selection of colour schemes for the door 
 
 

 

‘Doors’ - this button allows the selection of materials for elements of 
the wardrobe door (Fig. 99), both their type and colours. The first step, 
identify the group of systems and the exact door system.  

 
 

A similar situation occurred in the 
last step of the ‘Basic Options 
Wizard’, but then hardware and 
partition profiles were not 
available (more information on 
this topic can be found in section 
3.8 on page 16). More additional 
options for doors are also 
available in the ‘Options’ tab in 
the top menu (fifth icon: ‘Sliding 
Door Editor’). There you can set 
the parameters for door leaves 
and tracks, apply materials and 
graphics, and define arc and 
straight divisions of the doors.  
  

Fig. 99 - Selection of models and colour of the door elements  

5.7. ‘Summary’ tab 

 
 

 

 

‘Errors’ - this option examines all irregularities that occurred in the 
wardrobe design and displays their full list (Fig. 100). When you click on a
position on the list, the program will locate the particular error in the 
design, so you know which element should be modified and how. 

 

 
Fig. 100 - List of the errors found in the design 

 

 

‘Reports’ - generates a list of components and quantitative elements 
(Fig. 105), their valuation (Figure 115 on page 56), and three types of 
reports - standard or detailed for the client, and report for production 
(Figures 119, 120, 121, 122 and 123 on pages 57 - 59). 
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Before you can access the reports, dimension 
allowances must be defined. The ‘Machining 
allowances’ window in which you can do it, 
opens after selecting the ‘Reports’ icon (Fig. 
101). Allowance is a layer of material that is 
removed as a result of material processing (for 
more information see section 4.5 on page 25). 
After setting the allowances for various 
wardrobe components, they will be added to 
the price of the individual elements.   

Fig. 101 - Setting the allowance 

 

 
Fig. 102 - Summary of components and quantitative elements for the designed wardrobe 

 
5.7.1. Options available in the ‘Components and quantitative elements’ tab 
 

Functions are available in the summary window under the buttons at the bottom of 
the screen: ‘Add a panel’, ‘Add a longitudinal element’, ‘Add a profile’, ‘Add another 
element’ and ‘Exchange rate’. The first four icons, located in the lower left corner of 
the window, allow you to add elements to the list that are not included in the design, 
but are required by the contractor, such as spare parts.   
 
The ‘Exchange rate’ button in the ‘Currency’ panel on the right side of the window 
allows you to set the current exchange rate, if you need to change the currency (Fig. 
110 on page 54).  
 
Additionally, after selecting a position in the summary and clicking the right mouse 
button, you gain access to the ‘Edit comment’ option (Fig. 103). A note entered in the 
‘Edit comment’ dialog box will be displayed in the detailed report for a client and the 
report for production  (Fig. 104). 
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Fig. 103 – adding a comment to the position ‘Wardrobe top – Roof - Board 18 mm – White Hacienda…’ 

 

 
Fig. 104 – a part of the report for production with the exemplary comment 

 

 

‘Add a board’ - allows you to add and select the material (wood and 
wood-like materials, glass, mirrors, rattan, chipboard, MDF, Lacobel glass 
panes, bamboo) and enter the dimensions of the panel (Fig. 105). 

 

 
Fig. 105 - Adding a panel to the report 

 
 

 

‘Add a longitudinal element’ - with this button other items, can be 
added to the summary and price including mouldings, gaskets, anti-dust 
brush pile seals, flanges, rods, risers recessed into the wood, upper and 
lower tracks, conversion tracks, track covers, decorative profiles and 
studded on panels, buffer strips (Fig. 106). 
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Fig. 106 - Adding a longitudinal element (edging) to the report 

 

 

 

‘Add a profile’ - allows you to add profiles, connectors, angle bars and T-
profiles to the list elements (Fig. 107).  
 

 

 

 
Fig. 107 - Adding a profile to the list of components 

 
 

 

‘Add another element’ - this function gives you the ability to add: locks, 
halogens, sliders, handles, pull down hangers, baskets, brakes, stops, 
pivots, casings, closing mechanisms, caps, hinges and many other 
components (Fig. 108).  
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Fig. 108 - Adding a pantograph to the list of components 

 

 

‘Exchange rates’ - in the valuation window you can also change the used 
currency and the its exchange rate (in the ‘Currency’ panel in the bottom 
side of the window - Figures 109 and 110). After changing the currency 
the program will remind you to check the current rates (Fig. 111).  
 

 

 
 

 
Fig. 109 - ‘Currency’      

panel 

 
Fig. 110 – Changing the exchange rate 

 
 
 
 

 
Fig. 111 - Reminder to check the current exchange rate 

when changing the currency 

 
5.7.2. Options available in the ‘Estimated valuation’ tab 
 

When you switch to the second tab in the ‘Valuation’ window, you gain access to the 
estimated price of the used and added elements (Fig. 112). It includes the information 
about the element (description), quantity and units (pieces, metres or square metres), 
price, discount (percentage- and amount-based), installation costs, and value.  
 
The editable items in the ‘Valuation’ tab are ‘Discount [%]’ and ‘Discount [$]’ (Figure 
112). To change them, double-click in the appropriate field in the table and enter the 
new value. Then click in some other field. The discount will be changed. 
 

Note! At present moment the pricing option in the Wardrobe Module does not take into account 
the cutting of furniture boards, so it should be treated only as an estimation valuation. 
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Fig. 112 - Wardrobe design estimated valuation – editing the discount value 

 
5.7.3. Options available in the ‘Report’ tab 
 

Illustrations on the following pages present reports for the client and for production 
(Figures 119, 120, 121, 122 and 123 on pages 57 - 69). There are three functions 
available under the icons next to the filter at the top of the window. In the filter can 
choose the type of report you want to display. 
 

 
‘Refresh the report’ - loads the most recent data in the report, useful when 
you add elements or change discounts after you have generated the report. 
 
 

 

 

‘Export to PDF’ - exports the report for the customer or contractor to PDF.  
 

 
 

 

‘Export to CSV’ - saves the data on the boards used in the wardrobe design in 
the files readable by CAD Cut. Analogical files are also automatically saved in 
the ‘rozkroj’ directory  when you finish your work with the module (exemplary 
location: c:\CadProjekt\ CAD Decor Pro\Szafy Wnekowe\rozkroj\) (files 
marked with _mag.csv and _base.csv). During exporting to CSV the module 
saves the data of all wardrobe components (formats) to the file 
marked_base.csv (Fig. 113), which is saved in a location specified by a user. 

 

 
Fig. 113 - CVS file containing data of the components of the wardrobe (cutting formats) 
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The second file marked _mag.csv (also saved in a desired location) contains 
dimensions of material sheets that will be necessary to cut out formats (Fig. 114). 
 

 
Fig. 114 - CVS file with hypothetical sheets in stock 

 
All of the above CSV files can be imported to the CAD Cut program, by selecting the 
function File  Import  Text files (select _base.csv file) and File  Import  
Magazine status text files (select _mag.csv file) (Figure 115). When you select a text 
file import and find the file location on disk, change the desired file extension to CSV 
extension (default is TXT) (Figure 116). 
 
 
 

 
Fig. 115 - Import of text files to 

 CAD Cut 
Fig. 116 - Changing the type of file to be imported 

 
The illustration on a next page presents a list of formats and sheets imported to CAD 
Cut (Figure 118 on the next page). More information about CAD Cut can be found at 
our website: www.cadprojekt.com.pl/strefa_informacyjna/cad-rozkroj-4x.html. 
 

After selecting,  ‘Report 
header editor’ in the upper 
right corner of the ‘Valuation’ 
window, you can upload the 
logo and name of the studio 
(Fig. 117). 

 

 
Fig. 117 - exemplary report header 
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 Fig. 118 - Exemplary list of formats and sheets, imported to CAD Cut from file exported during wardrobe design valuation 
 
The following figures show exemplary reports for the client and for production. 
 

 
Fig. 119 - Exemplary standard report for a client  
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Fig. 120 - Exemplary detailed report for a client 

 

 
Fig. 121 - Exemplary report for production - vector images 
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Fig. 122 - Exemplary report for production - list of elements, hyperlinks to board schemes 

 

 
Fig. 123 - Exemplary report for production - format scheme 

 
6. Other options - editing the wardrobe model visualisation 
 

6.1. Introduction 
 

In addition to the functions described in the previous section of this manual, Wardrobe 
Module also allows for editing and modifying the interactive preview of the wardrobe 
model. This can be done in two ways - by clicking on the various moving parts of the 
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closet and moving them with the mouse, or by using the options in the context menu, 
available by right-clicking. 
 
6.2. Dynamic modelling of a wardrobe design in the visualisation 
 

This function applies only to the movable wardrobe components, such as partitions, 
shelves, drawers, rods and accessories. To use it, click the left mouse button on the 
selected element - a rectangular red outline and orange arrows will appear around the 
element indicating the possible direction of movement (Fig. 124). 
 
To move an element, place the mouse cursor over the orange arrow, press the left 
button and move the mouse in the desired direction. The arrow shows the current 
distance to the floor - when the desired value is set, release the mouse button. When 
you move the main storage shelf, you can also evenly spread elements in the cells 
underneath the shelf - holding [Ctrl] when you move the mouse cursor.  

 

 
Fig. 124 - Using dynamic modelling function - moving shelves in the preview using the mouse 

It may be useful to change the offset at which selected items move. To do it, mark an 
item, press the right mouse button and select the ‘Reposition offset’ from the context 
menu. For more information on the reposition offset, please go to page 64.  

 
6.3. Context menu in the visualisation 
 

While working in the visualization of the wardrobe design, you can mark elements and 
subject them to various operations, available in the context menu under the right 
mouse button. The list of available options depends on the type of a selected item. 

Note! By double-clicking on the orange arrow you can open a little window called ’Cell dimensions’ 
in the left upper corner of the screen, in which you can define the offset value for the edited item.  
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6.3.1. ‘Edit’ option  
 

It is available for all elements of the wardrobe and the cells. It allows you to change the 
size and other settings - different depending on the type of object selected. 
 

 

Cell edition - double-clicking inside a cell or selecting it by 
left-clicking and choosing the ‘Edit’ option from the 
context menu opens a ‘Cell window, where you can check 
its dimensions (but you cannot edit them here) (Fig. 125). 

 
Fig. 125 - Editing an empty cell 

 

Partition edition - here you can (Fig. 126):  
- set material for the board and the edging; 
- select edges to be veneered; 
- change partition’s location in a cell - move it 

right or left by using  buttons, 
- set an offset ‘in depth’ (the distance between 

the door and partition’s edge inside the cell). 
 

If the partition has been divided before edition, 
you will see a list of its parts in the ‘Elements’ 
pane (Fig. 126). You can edit them and: 
 

 decide whether they should be visible (in the 
Wardrobe Module and in CAD environment 
and visualization of the main program),   

 change their height by moving upper or 
bottom borders (using  buttons); 

 choose edges to be veneered.  

 
 

 

 
Fig. 126 - Editing a partition  

 
Shelf edition - after editing a shelf, the ‘Shelves’ 
window appears (Fig. 127), in which you can: 

- select the colour of the panel and the rim; 
- identify the edges that are to be veneered (by 

placing a check in the appropriate box); 
- change the position of the shelf (move it up or 

down or away from the front of the cell - using 
the  buttons or by entering the value 
manually).  

 
Changes are presented in the wardrobe 
preview. When modifying numerical values, you 
need to click on another edit box to update the  

Fig. 127 - Editing a shelf 
 

Note! Changing the offset between the partition and the front of the wardrobe (front edge of the 
cell) causes the corresponding offset of shelves and accessories (change of their depth). 
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preview. 
 
Drawer edition - (Fig. 128) enables you to: 
- changing height of an edited drawer, 
- selecting schemes, f. e. created by you (more 

information on how to create user own 
drawer schemes can be found in section 
4.5.1. on page 26); 

- selection of sliders, the panel and the rim of 
the front and handles; 

- the distance of the front of the drawer from 
the front of the cell; 

- indication of the number of holders; 
- indication of the edge of the various 

components of the drawer (front, rear, left 
and right panels and bottom) to be veneered 
(to select them, in the first place select the 
item in the list on the left, for example, the 
bottom - as shown in the drawing to the 
right – Fig. 128).  

 
Rod edition - (Fig. 129) available options:  
- checking the dimensions of the cell in which 

the rod is placed; 
- selection of a specific rod model;  
- setting a new position using the  

buttons; 
- selection of the type of mounting and 

connection to the panels or other rods 
(these elements are not visible in the 
visualisation, but are included in the list and 
the price estimate of the wardrobe design). 

 
Fig. 128 - Editing a drawer 

 

 
Fig. 129 - Editing a horizontal rod 

Accessories edition  - opens the ‘Accessories’ window, where you can: 
- check the dimensions of the cell in which the edited accessory item is located; 
- change the type of the inserted accessory (you can choose different types of 

baskets, pull-out shelves, shoe racks or other) (Fig. 130); 
- for the pull-out shelves, you can also set the colour of the panel and the rim, and 

the type of sliders. The sliders are not visible in the preview, but are included in 
the list and the price estimate of the wardrobe design. 
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Fig. 130- Editing accessories - selection of other elements 

 

 Divisions edition on door leaves: 
- while working in the ‘Sliding door editor’ (available under the fifth icon in the 

‘Options’ tab in the main module menu), you can edit divisions you added to 
particular door leaves, f. e. to change a straight division info an arc one, to obtain 
effect presented below (Fig. 131) – using option ‘Add arc’; 

- if you want the arc to be bent in another way, select the ‘Reverse’ option; 
- arc divisions can also be edited; it is possible to add more arcs to an existing arc 

and creating a wave – using option ‘Add arc’ for 2 or 3 times; 
- location and shape of a selected division can be simply modified by clicking on 

characteristic point and moving the mouse. 
 

 
Fig. 131 – Editing door divisions – changing straight division into an arc one 

6.3.2. Other options in the context menu 
 

 ‘Copy’ - copy the selected item, cell or multiple cells; after copying, you can paste 
them to another location (another cell). 

 ‘Distribute evenly’ - this function applies to the arrangement of the shelves, rods 
and other accessories; when you select a whole cell, which includes several 
elements, and you choose this option, they will automatically be placed at equal 
distances from each other, evenly throughout the space of the cell. 

 ‘Deselect’ - will deselect the elements or cells marked. 
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 ‘Arrange upwards/ downwards’ – moves all elements in the indicated cell  to its 
top or bottom edge. It applied to all elements despite the main shelves – when 
they are present in the indicated cell, the functions are not available. 

  ‘Clear the cell’ - removes all elements in the cell. 
 ‘Divide boards’ - function available after selecting the ceiling, shelves, partitions or 

floor; enables the selection of the location of transverse divisions of boards. 
 ‘Delete divisions of boards’ - this option appears in the context menu when you 

select an object, to which the board division lines were previously applied; its use 
results in the disappearance of all divisions on the given object. 

 ‘Move front/back’ - appears when you select a pull down hanger or vertical rod; 
lets you switch to the mode of moving to the back and front of the wardrobe 
(orange arrow determining the direction of movement changes the position). 

 ‘Move left/right’ - similar option to that described above, available for longitudinal 
rods; it can change their position, moving them from side to side (orange arrow 
changes direction to the ‘sideways’).  

 

 ‘Save module’ - available when you select the 
entire module (i.e. cells with added elements 
such as shelves, accessories, etc.) (note: it is 
sometimes necessary to click for a few times to 
select the parent units). Opens the ‘User 
modules’ window and saves the selected 
module on the disk. The created module can be 
directly inserted into the design (Fig. 132). If 
you do not intend to use the saved module 
straight away, close the ‘User modules’ window 
by clicking on the red cross . The stored user 
modules can be used at any time by going to 
the ‘Modules’ tab in the panel on the left side 
of the screen, and selecting the option ‘User’ 
and then selecting to the appropriate module 
from the list and clicking ‘Insert’.  

 

 
Fig. 132 - Adding a new user module 

 
 

 
Fig. 133 - Editing reposition offset 

 

 ‘Reposition offset’ - function available after selecting the movable elements 
(shelves, partitions, rod, etc.). It opens a window ‘Define the reposition offset’ and 
allows you to change the amount by which elements move according to your needs 
(Fig. 133 above).  

The most precise reposition offset would be 1 millimeter, but such settings would 
cause a slowness of movement, so a more convenient unit has set: every 10 mm. The 
default reposition offset is also set to 10 mm. 
 ‘Pull out’ - option available for drawers and 

accessories; pulls out the selected item, 
beyond the front border of the wardrobe - if 
there is no collision with the door. In such 
case, you will be notified (Fig. 134). Usually 
it is enough to move the doors so as they do 

 

 
Fig. 134 - Information about a conflict  

between the pull-out drawer and a door 
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to block the element you want to pull out. 
 
6.4. Combining elements into larger units 
 

Identical accessories can be connected to create elements twice their size.  To do so:  
 divide a partition and remove one part (make it invisible – see page 61); 
 place two identical items on both sides of removed fragment of partition e.g. rods, 

drawers (not occupying the whole cell), pantographs etc.; 
 locate them at exactly the same height (hold [Shift] while moving to align);   
 select both objects with a left-click and the right-click on any of them;  
 select the „Connect” option in the context menu (Fig. 135).  
 

 
Fig . 135 – connecting two rods into one 

 

 
Fig. 136 – two rods connected and going through two cells 

 
Connected elements can be moped, but only in the space created by removal of the 
partition board fragment. When you relocate any parent element relative to the cell 
with the divided board, or when you change any of wardrobe parameters, the 
combined elements will disconnect. After being re-set to the same height they can be 
re-combined into a single object again. To separate the items, right-click on the 
resulting object and select the ‘Disconnect’ option from the context menu. 
7. Completing work in the Wardrobe Module 
 

The work in the Wardrobe Module can end in three ways: 

 click the icon  ‘Close and insert the wardrobe without doors’ in the ‘Design’ 
tab, which exits the module and inserts the currently designed wardrobe in the 
design without doors, allowing you to see the inside of the cabinet in the 
visualisation without removing the door. 
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 click the icon  ‘Close and insert the wardrobe’ in the ‘Design’ tab, which exits 
the module while inserting the currently worked on wardrobe in the previously 
specified location in CAD Decor, CAD Kitchens or CAD Decor PRO. 
 

 click the cross  ‘Close’ in the upper 
right corner of the screen. You will be asked 
whether you want the wardrobe to be 
inserted in the design in CAD Decor, CAD 
Kitchens or CAD Decor PRO or not (Fig. 
137). This option is especially useful when 
you want to drop changes made in an 
already existing wardrobe which has been 
edited after insertion in CAD programs. 

 

 
Fig. 137 – the module wants to know whether 
the designed wardrobe is to be inserted in the 

design created in CAD Decor PRO program 

 
In the CAD environment the wardrobe is one solid block. When you click on any of the 
components, the entire model is selected. Therefore, it is not possible to move parts of 
the wardrobe independently, e. g. to change the position of door leaves or accessories. 
These operations can be carried out only by editing the wardrobe in the Wardrobe 
Module. To edit a wardrobe inserted in a CAD design, left-click and then right-click on 
it and select the ‘Edit’ option. The wardrobe may, however, be subjected to standard 
operations available in the context menu of CAD programs (except for the copying). 
More information about features available in the CAD environment can be found in 
the user manuals for our CAD programs that are available in the Designers zone on our 
website, in the Knowledge Center. 
 
In the visualisation of our CAD programs, the wardrobe will have the properties 
attributed to it in the Wardrobe Module (e.g. designated colours, materials selected in 
the ‘Sliding door editor’ - go to pages 30 – 34 for more information).  
 
While working in the visualisation of CAD Decor, CAD Kitchens or CAD Decor PRO you 
can apply other materials or change the properties (e.g. transparency, reflections, 
gloss), but these changes will not be visible by the Wardrobe Module when you edit 
that particular wardrobe. For example, materials applied in CAD program visualisation 
will not be included in the valuation of the wardrobe design in the Wardrobe Module, 
and when you edit a wardrobe, its properties previously assigned to it in the ‘Front 
editor’ will be restored. At the same time properties set in the visualization of CAD 
Decor, CAD Kitchens or CAD Decor PRO will be disregarded by the Wardrobe Module. 
8. Exemplary visualisations of interiors with recessed wardrobes 
 

Visualisations presented on the following pages (Figures 138– 142) have been made in 
the CAD Decor PRO program, using the advanced features available in the Professional 
Rendering Module. All presented wardrobes were designed in the Wardrobe Module, 
the functions and operation of which have been described in the above manual. 
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Fig. 138 - Exemplary visualisation 1 – wardrobe with glass doors 

 

 
Fig. 139 - Exemplary visualisation 2 – wardrobe with a bevel and straight front divisions 
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Fig. 140 - Exemplary visualisation 3 – wardrobe without doors 

 

 
Fig. 141 - Exemplary visualisation 4 – the same wardrobe with doors with circular divisions 
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Fig. 142 - Exemplary visualisation 6 – edge wardrobe 

 
 
 
 
 

 



 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 


